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1 Meridian Overview

Meridian is the Electronic Document Management System (EDMS) that is used by the
Infrastructure Planning and Facilities Unit at Michigan State University.  It has various
capabilities for storing and managing many different types of files.

This manual covers the following basic concepts in Meridian:

· Vaults

· User Interface

· Viewing

· Scopes & Navigational Views (Nav Views)

· Searching
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2 Introduction to Meridian and General Overview

2.1 How to get to Meridian

If you don't have a Meridian shortcut already...
1. Type 'Meridian' in the search box.
2.  Click on 'Meridian'.
3.  Once Meridian is open, right click on the icon in the taskbar and select 'Pin to
Taskbar'.
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2.2 Security/Permissions

All access in Meridian is permission based.  There are 3 levels of security:

Public - Anyone with a user account can see these documents.

Private - Access is limited to only users in the group and set up on a case by case
basis.

Obsolete - Documents that are no longer used, but we want to keep a record of them.
 These files don't appear on our web pages or in search results.

2.3 Vaults

Meridian uses a concept called 'Vaults' .   Each vault is a predefined set of related
documents.   A vault is essentially a digital filing cabinet.

Because of the sheer volume of documents and drawings in the system, the data in
Meridian is separated into various vaults.  Vaults are important for searching, as they
are the first step in getting to the information you are seeking.
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2.3.1 Accessing Vaults

The are two different ways to access the vaults in Meridian.

1. Using the 'Vault' menu

 

2.  Or, using the 'Vault' icon
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3.  Select which vault you want to open
4.  Click 'OK'

2.3.2 Where am I?

Once you select a vault, you can always tell which vault you are in by looking at the
top of the Meridian application window, the top of folder structure or the bottom of the
Meridian application window.
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2.3.3 Document Types within Vaults

The 'document type' specifies the business meaning of a document.  The archive
vaults are split into separate areas that contain similar document types.  The
Operational Vault contains many different document types, some related and some
not.
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2.3.3.1 Project Archives Vaults

There are four Project Archives Vaults that house all the facility, infrastructure and
construction related documents, drawings and equipment & material data.

Project Archives - Documents, General Warranties
oProject Documents  (Specifications, Addenda, Bulletins, Correspondence,

Reports, Studies, Testing, Hazardous Materials, etc)
oGeneral Warranties  (Contractor and Subcontractor Warranties)

Project Archives - Drawings
oProject Drawings  (As-Builts, Control Drawings, Bid Sets, Surveys, Design

Development, etc.)

Project Archives - Equipment & Materials (all tracked and non-tracked asset
information)
oShop Drawings (submittals, product data)
oOperation & Maintenance Manuals  (submittals, product data)
oEquipment and Material Warranties  (manufacturer and extended warranties)
o Testing and Readings (installation and inspection/scheduled testing)
oService and Maintenance (trouble calls, fixing assets)
oPM Scheduling (scheduled preventive maintenance)
oAsset Number Updates (worksheets for assets installed or removed)
o Training (training manuals and videos from manufacturers or installers)

Staging
o Files from closed Unifier BP records that need further description.
o The files are bulk added under a project number, then a subject matter expert can

go and index them accordingly.
oAs this is done, the completed files move into the appropriate archive vault in

Meridian.

· All documents will be added to Meridian after project closeout.
· We are in the process of adding all microfilmed documents into Meridian (1855-2003

project document and shop drawing information).
· Most of the active project information is housed in Unifier as we work on adding the

closed records to Meridian.
· Some files are still hard copy in the Archives room.
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2.3.3.2 Operational Vault

The Operational Vault houses many different types of document types.

Unit Reports
oUnit wide and Departmental Reports

Facilities Data Reports
oStatic annual reports regarding facility and infrastructure data for MSU.
o The current reports using the most up-to-date information and static fiscal year

end reports are available on the FIT home page
(https://apps.gis.msu.edu/facilities-information-tool/v4/).

Construction Standards
oUsed to create the project specifications and drawings.
oMeridian houses both the MSU standards for construction and standard details.  
oProvides users access to the most current versions.
oA select group of individuals have editor privileges.
o Files are linked to external web pages..
oSee Construction Standards training materials if you are an editor in this area.

Forms and Templates 
oProvides users access to the most current version of the form or template.
oCan be saved directly into a project and filled in without changing the master form

content.
oA select group of individuals have editor privileges.
o Files are linked to various external web pages.
oSee Forms and Templates - Editor training materials if you are an editor in this

area.

Policies, Procedures & References
oProvides users access to the most current version of the Policy, Procedure or

Reference.
oA select group of individuals have editor privileges.
o Files are linked to various external web pages.
oSee Policies, Procedures & References - Editor training materials if you have

access to use this area.

Operational Drawings
oProvides base floor plan information (walls, windows, doors, room numbers,

square footage, door swings).
oHouses the dwg and pdf base building floor plans, Building Information Models in

Revit and evacuation maps.
o Files are linked to mapping system and external web pages.

Staff

https://apps.gis.msu.edu/facilities-information-tool/v4/
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oPDC student staff photographs and reviews which you can view with certain
permissions.

Projects
o IPF staff can manage and collaborate on their files pertaining to facility and/or

infrastructure related projects they are involved in.
o It is split into two areas: Project Documents and Project Drawings.
oUsers pull 'Forms, 'Operational Drawings' and 'Construction Standards' files from

other areas of the Operational Vault and make them part of the project.
o This allows for the project files to be available to all who need them at all times.
o These are NOT the final versions of the files and WILL NOT be archived.
oSee Projects training materials if you have access to use this area.

Tasks (Non-project related efforts)
o IPF employees can store any files they worked on that did NOT have to do with an

official facility and/or infrastructure related project.
oA task should only be created if it has NOTHING to do with an official facility

and/or infrastructure project.
oSee Tasks training materials if you have access to this area.

Safety Data Sheets
o IPF departmental MSDS and SDS documents are stored here and filed according

to chemical type, department using the chemical, etc.
o The files are managed by the Occupational Health and Safety department.
o The files can also be accessed on the IPF Hub or mobile meridian.
oSee Safety Data Sheet training materials(Editor or Viewer) if you have access to

this area.
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2.4 User Interface

The Desktop Client user interface will look very similar across the Vaults.  The folders,
document properties and underlying data will change, but the icons and menus will
remain mostly the same.

2.4.1 Toolbars

The toolbars in Meridian have many different options.  Most of these options are also
available as icons.

***You must select a file to have the all the options in the toolbar and menus
appear.***

1. Change vaults
2. 'Nav View' access
3. 'Go back in time' feature
4. 'Edit' menu to copy files
5. 'Document' menu for sending email, building reports, printing
6. 'Tools menu' for access to FIT, the project selection tool and the 'Find Tool' (for

searching).
7. Toggle viewer and properties pane on and off
8. 'Find Toolbar' for searching
9. Scopes access (Operational Vault Only)
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2.4.1.1 User Settings

2.4.1.1.1  Arrange Layout

Floating/Docking Viewer and Properties Pane:

On the Properties Pane or the Viewer window, the user can float (drag and drop) the 'viewer' or

'Properties' to any part of your desktop screen (inside or outside of Meridian).  To re-dock, drag

and drop back into the Meridian application and select the location where the block is

highlighted.

2.4.1.1.2  Options

Options:

 This feature allows the user to set specific user preferences. 

Startup Options - allows the user to return to where they left off in Meridian upon
opening the application and to stay on a particular document when switching between
views.

1. Click on the 'View' menu
2. Select 'Options...'
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3.  Check the boxes under 'Startup'.

This will ensure Meridian opens to the last place you were if you close the application
and will take you to your selected document if you switch views within a vault where
your selected document would appear.

Settings for Right-Click Menu - shortcut to the 'document menu' options when you
right-click on a document.

1.  Click on the 'Appearance' tab
2.  Click on the 'Configure...' button
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3.  Scroll down a little
4.  Check the boxes for the options you want in your right-click shortcut menu
5.  Click 'OK'
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6.  Click 'Apply'
7.  Then click 'OK'
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2.4.1.2 Tools

Tools:

Users have access to:
· The Find Documents Tool (which will be covered under the searching section of this

manual)

· FIS Tools - a list of applications designed to assist users with finding MSU building,
infrastructure & project information

· View or Administer Projects and Tasks - access to the project information tool within
Meridian

2.4.1.2.1  FIS Tools

To assist the user in finding the information they are looking for, FIS has created the
'FIS Tools'. This toolbox offers the user the ability to search for many different types
of facility and infrastructure data.  They can search on one or a combination of the
criteria to find what the are looking for.
1.  Open the 'Tools' menu and select 'FIS Tools':

The following dialog box will appear showing the applications offered to help users find
information.  Select the tool you want to use and click OK.



Introduction to Meridian and General Overview 17

© 2023 Michigan State University

2.4.1.2.1.1  FIS Support Portal

The FIS Support Portal (https://fissupport.ipf.msu.edu/Main/) contains information
about troubleshooting issues, news alerts about systems and applications, links to
various applications, knowledge based articles and user support via ticket submission
to our service desk and contact information.

https://fissupport.ipf.msu.edu/Main/
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2.4.1.2.1.2  Facilities Information Tool

The Facilities Information Tool (FIT) is your connection to facilities
and infrastructure data, project information, infrastructure mapping
and electronic document management content.  Various links on
the FIT page will send you directly to the files in Meridian Explorer.

· The menu on the left hand side of the application window
provides shortcuts to all the different sets of information.

· Most of the links within FIT are accessible in each area.  There are
multiple ways to search for the information and then access the
same information.

For further instruction, see the Meridian Explorer Training Manual
or the 'WHAT'S NEW?' menu option within FIT.

https://apps.gis.msu.edu/facilities-information-tool/v4/
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The FIT Project Database grants users access to the list of projects
for the facilities and infrastructure at MSU.  To search for projects
within a certain building, it is best to start in the building search.

Users can search for information using project keywords (portions
of project names, project numbers, building names, building
numbers).

· Type the keyword and hit enter.  This will return results that have
that keyword in the project name, number, building name or
number.

· Filter the list further by typing another keyword.  DO NOT HIT
ENTER - this will clear the previous keyword search and you will
start over.

· Click on the project number to access the project files in Meridian
Explorer, print a project cover sheet or copy the project
information (number and name) to the clipboard.
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· Click on any of the column header filters to filter the results
further.

Multi-Building Projects:
Occasionally IPF will perform a multi-building project, meaning one project number is
assigned to a project that encompasses two or more buildings or land entities.

The electronic systems used here at IPFf or projects, FAMIS and Meridian, only allow
for a one-to-one building/project relationship. When we perform a single project on
multiple buildings, we are forced to pick a 'primary building', even though the work may
be split evenly amongst the buildings.

The Project Database allows the user to search for any building that was involved in
the project and find the information needed to conduct a search in Meridian or FAMIS.

Within the the search results for a building, you may notice different 'Primary Buildings'
listed other than the building you searched for.  In this instance, you will want to use
the Project 'Number' or the 'Primary Building' to search in Meridian.

Examples Below with Explanations:
1. This is a Sewer distribution project that also included Berkey Hall.  Sewer

Distribution (9572) is the primary building.  If you looked in Meridian for these files
using the Nav Views that use building name or building number, the files WILL NOT
be there.  They are filed under Sewer Distribution.  If you search under the project
number (REC007335) or used the Find tool (instructions later) under '0002 Berkey
Hall' - the files will be there.

2. This is a project only for Berkey Hall.  No matter which way you search in the
system (Project number, Building Name, Building Number), the files will show up.

3. This is a multi-building project where Berkey Hall is the primary building.  The files
are stored in 0002 Berkey Hall.  If you use the Nav Views and search Berkey Hall,
the files will be there.  If you searched using the Nav Views for any of the other
buildings listed, the files will not be there in the Nav Views.  The files will however
show up if you use the project number (REC001911) or used the Find tool
(instructions later) with any of the other building numbers/names.
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2.4.2 Views

There are many different types of 'Views' in Meridian.  The system will default to the
'Folders' view, which should not be used for searching.  If you click on the word
'Folder', it will display a list of Navigational Views you can use to search.

Folders - Root folder where the files in Meridian are stored based on permissions and
security.

DO NOT USE IF YOU ARE SEARCHING FOR
DOCUMENTS. 
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My Working Copies (Archive Vaults)/ [My to-do list] (Operational Vault) - view
designed to show the user all the documents they are currently working on (in 'Quick
Change' status)

oArchive Vaults:

oOperational Vault:

Navigational Views - Predefined searches based on specified document
properties.  Many different options that are different in each vault.

oArchive Vaults:

oOperational Vault:

oCollections: (user defined saved searches - set by using Advanced
Searching or Find Tool)
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Find Results - Shows when you have conducted a search with the Find Toolbar

Scopes- Filters the list of Navigational Views to a subset used by a specific Meridian
user group (used in Operational Vault only)

2.4.2.1 Scopes & Navigational Views

Scopes

· Narrow the focus of the Navigational Views to a subset used by a specific Meridian
user group.

· Used only in the Operational Vault because there are many different IPF groups
using Meridian for different things.

· Upon opening the Operational Vault the first time, you will be asked to select a
scope.
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Navigational Views (Nav Views)
· Will direct you to certain documents based on a predefined path of specified

properties.
· Currently are based on the criteria and order in which we believe most people like to

search and retrieve the information they are seeking.
· Vault specific, meaning they only search through the documents in the vault you have

open.
example below: project archives - documents
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2.4.2.1.1  Navigating Nav Views

Each Nav View will return a specific set of filtered information based on its name. 
Once you have selected your Nav View, you can drill down to the information you are
looking for.  The names of the Nav Views describe the type of documents you will see
and the order the folders will be in.

example from the Project Archives Drawings vault:
1. Anything before the parentheses indicates the filter parameters
o  'All Files' means every drawing type in the vault, NOT filtered on as-built, control

drawing, survey, etc.

a. Anything in parentheses denotes the folder structure that will be displayed.
o  Building - building name
o  Project - project information (number and name from the FIS project database)
o  Classification - what kind of document it is, document type, name, etc. (as-built,

bid set, control drawing, survey, etc)
o  Discipline - discipline class of drawing (arch, mech, civil, struct, elec, site, land,

equip, demo)
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*Remember - Nav Views in other vaults won't have the same choices and will be
specific to the files in those vaults.

2.4.2.2 Viewing Files

Users can also double-click to open the document in a native application on their
desktop.

2.4.2.2.1  Native Viewer (TIF)

Some of the files in Meridian are stored as TIF images.  This format was used before
PDF/a for archiving documents and drawings and we are working on replacing the TIF
files with PDF/a files.  In order for you to be able to view TIF files correctly, you may
have to set the default viewer to Irfanview on your computer one time.

  If you do not see this icon next to TIF files in Meridian, follow the steps below.

1. From Meridian, copy and paste (or drag and drop) a TIF file onto your desktop.

2.  Right click on the file on your desktop and choose 'Properties'



Introduction to Meridian and General Overview 27

© 2023 Michigan State University

 

3.  Select 'Change'.

4.  Choose' IrfanView'.  This viewer is the most compatible with different TIF formats.
5.  Click 'OK'.
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6.  Verify IrfanView was selected.
7.  Click Apply.
8.  Click 'OK'.
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9. Now delete the file from your desktop.  Close and reopen Meridian.

3 Searching

There are 4 different approaches to searching in Meridian:

1. Navigational Views (Nav Views) - covered earlier in manual
2. Find Toolbar
3. Find Documents Tool (Collections)
4. Advanced Search (available upon request)
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*In order to conduct a search, the user may first need to access the tools menu
options to help find the project or building information.

3.1 Find Toolbar (Basic Search)

· Search on one specific document property across one or multiple vaults.
· The drop-down list contains only the properties for the vault you are currently in.
· Depending on whether you search in 'this vault' or 'all vaults', the search results will

be returned in a different format.

*The Records Tools are available to assist users in finding Project Numbers, Project
Names, Building Numbers, Building Names, etc to search against.

*Reminders:
· Searching using Building Name or Number will only give you results where that

buildings was chosen as the primary building.
· Searching using Project Number will return everything in the system for that specific

project.
· Searching using DocSubClass will return everything in the system with that

classification, against all projects or departments.
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3.1.1 Using Find Toolbar

1. Select the document property

2.  Select the search condition
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3. Type in or use the drop down menu to fill in the search criteria.

· Most properties include a drop down menu, but Project Number does not.  This
field is still a type in text field.

· As you type, the list will filter.

4. Select the Search Scope (this vault or all vaults)

5. Conduct the search

3.1.2 'This Vault' Search

A search conducted in 'This Vault' will take the user directly to the information they
searched for in the same vault they conducted the search in.
· If there are going to be a large amount of files returned, you will get a warning. 

Click on 'All' to get the results.
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3.1.3 'All Vaults' Search

A search conducted across 'All Vaults' will open a separate window that contains all
the document types across all Meridian vaults with the property that was searched
against. 

1. Bottom left corner tells you how many total files there are and how many are
shown.

2. '250 More..." button allows you to add to the number shown.
3. 'Go To' button will take you to the file you have selected.  If it is outside the vault

you conducted the search in, it will open a new instance of Meridian.
4. Vault column tells you which vault the document is in.

* This option is only available from the Archive Vaults and not in the Operational
Vault.

3.2 Find Documents tool

· Allows the user to search for files using the same list of values used to index them.
· Will only display results from the vault where the search was conducted.
· Using it will create a 'Collection' (a user defined saved search).

To access the Find Documents tool:
1. Open the 'Tools' menu
2. Select 'Find Documents'
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3.2.1 Using the Find Documents tool

1. The' Find Documents' tool will have different tabs and fields depending on which
vault you are conducting the search in.

2. Anywhere there is a magnifying glass icon ( ), use it to select search criteria
from the same values that were used to index the files. 

 

If your search returns no results, you will be asked if you want to save the search
anyway.
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3.2.2 Find Documents Tool Results - Collections

Creating Collections:

· Collections are created when the Find Documents Tool is used to search.
· They are unique to each user and displayed beneath the Nav Views.
· You will have control over naming and editing your collections.
· Collections are dynamic (meaning as records are added to the system, if they fall

under your collection criteria, they will be included when you view your collection).

1. To rename your collection, delete the system generated name and type your own.
2. Select how long you want thje collection available in your collection list.
3. Meridian will display the collection when you click 'Find Now'.
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Accessing Collections:
1. Click on the Nav View drop down list.
2. Look at the end of the list, beneath the gray line.
3. Select the collection you want to view.
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3.2.2.1 Editing Collections

To edit or delete the collections you have created:
1. Open the 'Vault' menu.
2. Select 'Collections...'.

3.Select the collection, then you can rename it, edit the properties of it or delete it.



FIS Searching Hints: 
Here are some of the helpful hints to remember when searching through the Meridian 
(EDMS). 
 

Microfilm (16 mm): 
• From 1855 – 2003, all project related documents and drawings were microfilmed.   

 Most project documents & 8.5x11 shop drawings from this time frame are NOT in the EDMS.  
 They have been converted to digital and the FIS staff can access them.  
 We re working on adding them to Meridian in conjunction with the Facility Condition 

Assessments happening for ADCI. 
Electronic Document Management Software (EDMS) introduced: 

• We started scanning projects into the EDMS in 2003. 
o Any project from 2003 - 2009 (before Unifier) that is ‘closed’ in FAMIS has been scanned and 

added into the Meridian Project Archives vaults. 
o If the project is not closed in FAMIS, any hard copies will be with the Project Team or in the 

IPF Archives room until the project closes and they are sorted and scanned. 
• Project Management Software (Unifier (2009), Plangrid (2019) and Autodesk Build (2023)) 
o If the project happened in a PM system, the information will be copied into Meridian Archives 

as the business process records are closed and will also remain in the PMS. 
o Staging Vault – As the files are copied from PM systems, they are added to the Staging Vault 

in Meridian.  They are filed under the project.  Little information is filled in at this point.  As it is 
filled in, the files will move to the appropriate Meridian archive vault. 

Project Source: 
• There are 4 types of project sources in the Meridian project database.  Projects are created 

hierarchically, meaning the If there is a PR or WO that rolls up to a CP, only the CP will be in the 
project database. 
o CAPITAL – (CP00000) 

 2003 – Present Day. 
 Projects are automatically created in Meridian upon creation in FAMIS. 

o PROJECT REQUEST – (PR000000) 
 2002 – Present Day 
 Projects are created in Meridian under the following circumstances: 

• FIS receives documents to add to the system. 
• Project Services project closeout process. 
• Interior Design or Landscape Architect project running through PDC. 

o WORK ORDER– (WO000000 or W0000000) 
 2002 – Present Day. 
 Projects are created in Meridian under the following circumstances: 

• FIS receives documents to add to the system. 
• Preventive Maintenance or Project Services project closeout process. 

o LEGACY – (0000 or REC000000) 
 1975 – 2003 - Card numbers (0000) 

• 4 digit numbers assigned to projects. 
• They were rolled over and re-used. 

 1855-1975 - there were no project numbers. (REC000000) 
• We created unique REC project numbers. 

 Files collected from other campus departments (CPP, LMO, REO) 
Equipment and Materials: 
o If there is an Equipment ID in FAMIS, we are trying to link the documents in the EDMS to that Equipment 

ID. 
o Information from the Equipment ID record in FAMIS is being synched with the information in Meridian to 

ensure the data is correctly indexed. 
Drawings: 
o Project drawing disciplines may be indexed incorrectly. 

• Site, civil, landscape may be indexed under architectural.  This is being corrected as we 
find them. 

• As-Builts are added to the EDMS as single page PDF/a files.  Any other drawing set is 
added as a multi-page PDF/a file. 

Campus Park and Planning and Real Estate Office Files: 
• The CPP and REO documents are being stored hard-copy in the FIS archives room. 
• The documents are pre-sorted into boxes and are getting assigned project numbers, sorted and 

scanned into Meridian.   
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